
1 
 

 

 

QARAQALPAQSTAN RESPUBLIKASÍ  

QANLÍKÓL RAYONÍ 

25-SANLÍ ULÍWMA ORTA BILIM BERIW MEKTEBI 

 

 

“FAYLLARDÍ NÁTIYJELI BASQARÍW”  

 temasın oqıtıwda interaktiv metodlardan paydalanıw.  

 

Ulıwma orta bilim beriw mektepleri informatika hám informaciyalıq 

texnologiyalar páni oqıtıwshıları ushın metodikalıq usınıs. 

 

Valiev Raxat Polatbaevich 

25-sanlı ulıwma orta bilim beriw mektebiniń 

 informatika hám informaciyalıq texnologiyalar páni oqıtıwshısı  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Qanlıkól-2025 



2 
 

 

ANNOTASIYA 

Bul metodikalıq usınıs 9-klaslarda "Fayllardı nátiyjeli basqarıw" temasın oqıwshılarǵa 

túsindiriwde ınteraktiv metodlardan paydalanıwǵa qaratılǵan. Bul metodikalıq usınısda: "Fayllardı 

nátiyjeli basqarıw" temasınıń aktuallıǵı hám áhmiyeti, interaktiv metodlardıń abzallıqları, temanı 

oqıtıwda qollanılıwı múmkin bolǵan ınteraktiv metodlar (mısallar menen), oqıwshılardıń bilimin 

bahalaw usılları haqqında máseleler kórip shıǵıladı. Ínteraktiv metodlar bolsa oqıwshılardı oqıw 

procesine aktiv tartadı, olardıń qızıǵıwshılıǵın oyatadı hám temanı jáne de tereń túsiniwge járdem 

beredi.  Bul metodikalıq usınıs arqalı siz, húrmetli ustazlar, oqıwshılarǵa "Fayllardı nátiyjeli 

basqarıw" temasın jáne de qızıqlı hám nátiyjeli jetkiziwge erisesiz. Oqıwshılardıń informaciya 

texnologiyaları salasındaǵı bilim hám kónlikpeleri asıwına úles qosasız. 

 

Gilt sózler: fayl, papka, fayl keńeytpesi, skrinshot, qawipsizlik, fayl importı, fayl eksportı, 

interaktiv metodlar, viktorina, test, bahalaw.   
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pedagogikalıq keńestıń 5-sanlı májilis bayanlaması qararı menen mektep kóleminde en jaydırıldı.  
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Kirisiw. 

"Fayllardı nátiyjeli basqarıw" temasın oqıtıwdıń aktuallıǵı hám áhmiyeti. 

Búgingi kúnde informaciyalıq texnologiyalar turmısımızdıń ajıralmas bólegine aylanıp 

úlgerdi. Jeke turmısımızda, jumıs ornımızda, yaki bilim alıwda derlik hár kúni informaciyalıq 

texnologiyalarǵa súyenemiz. Informacion texnologiyalar biziń jumısımızdı jeńilletip ǵana 

qoymastan, biziń bilimimizdi bekkemlew, jańa bilimler iyelewde de áhmiyetli orın iyeleydi.      

Kompyuter sawatxanlıǵı, atap aytqanda fayllardı nátiyjeli basqarıw kónlikpeleri hár bir 

paydalanıwshı ushın zárúrli áhmiyetke iye boladı. Sebebi har kúni derlik kompyuterde, noutbukda, 

planshet yaki smartfonlarda fayllar menen islesiwge májbúr bolamız. Hár túrli qurılmalarda 

fayllardıń keńeytpelerin túsiniw, fayllardı ashatuǵın programmalar biziń qurılmamızda bar yaki 

joqlıǵın biliw úlken áhmiyetke iye.   

Fayl qanday programmada jaratılǵanına qaray, ózine tán ózgesheliklerge iye boladı. 

Máselen, tekst penen islew programması járdeminde jaratılǵan fayl, elektron keste járdeminde 

jaratılǵan faylǵa qaraǵanda basqasha ózgeshelikke iye. Túrli programma yamasa maqsetke 

baylanısqan fayllar qaysı fayl keńeytpesinde ekenin paydalanıwshı hám kompyuter biliwi ushın 

olar belgilengen bolıwı kerek. Fayllardı belgilew usılı fayl keńeytpesi dep ataladı. 

Fayl keńeytpesi - bul fayl atınan keyin keletuǵın hám noqat menen ajıratılǵan bir neshe 

belgiden ibarat bolǵan bólim.  

Fayl keńeytpeleriniń áhmiyeti: 

• Fayl túrin anıqlaw: Fayl keńeytpesi operacion sistemaǵa hám programmalarǵa fayldıń 

qanday túrdegi maǵlıwmattı óz ishine alıwın jáne onı qanday programma menen ashıw 

múmkinligin anıqlawǵa járdem beredi. 

 • Programmalarǵa kórsetpe beriw: Fayl keńeytpesi programmalarǵa fayldı qanday 

formatta ekenligin kórsetedi. 

 • Fayllardı tártipke salıw: Fayl keńeytpeleri járdeminde fayllardı túrine qarap tártipke 

salıw múmkin. 

 • Izlewdi ańsatlastırıw: Fayl keńeytpeleri járdeminde kerekli fayllardı tezirek izlep tabıw 

múmkin. 

Oqıtıwshılarǵa máslahátler:  

 • Fayl keńeytpesi ne ekenligin jáne onıń áhmiyetin oqıwshılarǵa durıs hám tolıq túsindiriń. 

 • Fayl keńeytpeleri menen islewde itibarlı bolıw kerekligin uqtırıń. 

 • Oqıwshılarǵa kóp qollanılatuǵın fayl keńeytpelerin (mısalı .docx, .jpg, .pdf, .mp3) 

úyretiń. 

 • Fayl keńeytpeleri haqqında qosımsha maǵlıwmat alıw ushın internet resurslarınan 

paydalanıwdı usınıs etiń. 

 Bul metodikalıq usınıs " Fayllardı nátiyjeli basqarıw" temasın oqıwshılarǵa túsindiriwde 

ınteraktiv metodlardan paydalanıwǵa qaratılǵan. 

 Ne ushın ınteraktiv metodlar? 

  Dástúriy oqıtıw usılları oqıwshılardıń aktiv qatnasın hám ǵárezsiz pikirlewin 

rawajlandırıwǵa mudamı  jetkilikli emes. Ínteraktiv metodlar bolsa oqıwshılardı oqıw procesine 

aktiv tartadı, olardıń qızıǵıwshılıǵın oyatadı hám temanı jáne de tereń túsiniwge járdem beredi. 

 Bul metodikalıq usınısda fayllardı nátiyjeli basqarıw temasınıń aktuallıǵı hám áhmiyeti, interaktiv 

metodlardıń abzallıqları, temanı oqıtıwda qollanılıwı múmkin bolǵan ınteraktiv metodlar (mısallar 

menen), oqıwshılardıń bilimin bahalaw usılları sıyaqlı máseleler kórip shıǵıladı.  

Oqıtıwshı innovaciyalıq tálimde bárkámal shaxstı tárbiyalawda zárúrli faktor bolıp xızmet 

 etiwi kerekligin túsiniwi kerek. Hámiyshe “Birdey bolıw” oǵan tuwrı kelmeydi, onıń ushın bolsa 

oqıtıwshı intellektuallıq dárejesin turaqlı túrde rawajlandırıp barıw zárúr. “Sırtqı faktorlar tásiri” 

hám psixologiyalıq tosıqlardan qutılǵan oqıtıwshı innovaciyalıq  ózgerislerdiń tolıq haqılı 

qatnasıwshısı bola aladı. [3] 
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 Maqsetimiz: Bul metodikalıq usınıs arqalı Siz, húrmetli ustazlar, oqıwshılarǵa "Fayllardı 

nátiyjeli basqarıw" temasın jáne de qızıqlı hám nátiyjeli tárizde jetkiziwge erisesiz. Oqıwshılardıń 

informaciya texnologiyaları salasındaǵı bilim hám kónlikpeleri asıwına úles qosasız. 

 Bul metodikalıq usınıs sizge óz jumısıńızda ámeliy járdem beredi degen úmittemiz. 

Tiykarǵı bólim: 

1. "Fayllardı nátiyjeli basqarıw" teması boyınsha teoriyalıq bilimler. 

Kompyuter dúnyasında biz hár kúni hár qıylı fayllar menen islewimizge tuwrı keledi. 

Súwretler, hújjetler, muzıka, videolar - bulardıń hámmesi fayllar formasında saqlanadı.  

Fayl - kompyuterde maǵlıwmat saqlawshı disktıń atalǵan bólimi. Fayl óz belgisi (atı ) na iye 

boladı. Diskke maǵlıwmatlardı basqa bir jol menen jazıp bolmaydı: bir ǵana háripti diskke jazıw 

zárúr bolsa da, oǵan at berip, fayl kórinisinde yadta saqlaw kerek. Fayllar jumıs processinde 

tikkeley paydalanıwshı tárepinen jaratıladı. Fayldıń tiykarǵı belgileri - atı, ólshemi (bayt esabında), 

jaratılǵan sánesi (kún, ay, jıl), waqtı (saat hám minut). Fayl tiykarǵı atqa hám keńeytpege iye 

boladı. Fayl atı hám keńeytpesi bir-birinen noqat menen ajratıladı. Olar latın álipbesiniń úlken 

yamasa kishi háripleri, sanlar hám belgilerden ibarat bolıwı múmkin. [6] 

Bıraq bul fayllardı kompyuterimiz qanday túsinedi? Bul jerde fayl keńeytpeleri úlken rol 

oynaydı. Fayl keńeytpesi úsh yamasa tórt háripten ibarat bolıp fayldıń aqırında noqattan keyin 

keledi hám fayldıń túrin belgileydi. Mısalı, ".doc" 

keńeytpesi Microsoft Word hújjetin, ".jpg" keńeytpesi 

súwretti, ".mp3" keńeytpesi audio fayldı ańlatadı. 

(Qosımshalarda 1-kestede fayl keńeytpeleri hám olarǵa 

túsindirmeler berilgen) 

Fayl keńeytpeleriniń áhmiyeti júdá úlken. Olar 

kompyuterge fayldıń qanday túrdegi maǵlıwmatlardı 

saqlap turǵanın aytıp beredi. Bul maǵlıwmatqa 

tıykarlanıp, kompyuter fayldı ashıw ushın qaysı 

programmanı isletiwdi biledi. Mısalı, ".doc" 

keńeytpesine iye fayldı ashıw ushın Microsoft Word 

programması qollanıladı. Fayl keńeytpeleri sonıń 

menen birge, fayldıń qanday etip saqlanıwın da 

belgileydi. Mısalı, ".jpg" keńeytpesi súwretti qısılǵan 

halda saqlaw usılın belgileydi. Bul fayldı kishi 

kólemde saqlawǵa járdem beredi.  

Kompyuterimizde yaki basqa qurılmalarımızda 

fayllardı tártip penen saqlaw úlken áhmiyetke iye, sonda olardı ashıwdı qálesek qay jerden izlew 

kerekligin bilemiz.  Fayllardı basqarıwdan maqset izlep atırǵan faylımızdı tez hám ańsat tabıwdan 

ibarat. Paydalanatuǵın fayl túrlerin biliw zárúr áhmiyetke iye boladı. Eger qandayda bir 

programmadan paydalanıp atırǵan bolsańız hámde bul programma ushın sáykes kelmeytuǵın fayl 

keńeytpesine iye fayldı ashıwǵa háreket qılsańız, fayl zıyanlanadı. Bunı durıslaw ushın sistemanı 

bul qátege jol qoyıwdan aldınǵı jaǵdayına tikleymiz. Biraq, kópshilik programmalarda basqa 

programma oqıwı múmkin bolgan formatta saqlaw shárti menen fayl import hám eksport etiledi. 

Keyin bolsa basqa programmada jaratılgan fayldı ashıwıńız, kóriwińiz hám redaktorlawıńız 

múmkin. Waqıttıń ótiwi menen kompyuterimizde hár qıylı fayllar toplanıp qaladı. Bul fayllardı 

nátiyjeli basqarıw, olardı tez hám ańsat tabıwǵa járdem beredi. Fayl keńeytpelerin túsiniw hám 

olardı tuwrı basqarıw áhmiyetli rol oynaydı. 

Fayllardı túrleri boyınsha tártiplew: 

Fayllardı hár qıylı papkalarǵa jaylastırıw, olardı tabıwdı ańsatlastıradı. Mısalı, "Hújjetler", 

"Súwretler", "Muzıka" sıyaqlı papkalar jaratıń.  Papkalar ishinde hár qıylı fayllardı túrleri boyınsha 

jáne de tártiplew múmkin. Mısalı, "Hújjetler" papkasında "Is hújjetleri", "Jeke hújjetler", "Tálim" 

sıyaqlı papkalar jaratıń. 

1-súwret. (Sabaqlıqtaǵı 140-bettegi              

11-01- súwret.) Hár qıylı fayl túrleri bar. 
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 Fayl keńeytpelerin túsiniw: 

Fayl keńeytpesin túsiniw fayldıń túrin anıqlawǵa járdem beredi. Mısalı, ".docx" keńeytpesi 

Microsoft Word hújjetin, ".pdf" keńeytpesi PDF hújjetin, ".xlsx" keńeytpesi Excel kestesin 

ańlatadı. Fayl keńeytpesin túsiniw arqalı siz fayldı qaysı programma menen ashıwdı bilesiz. 

 Fayl keńeytpelerin ózgertiw: 

Ayırım jaǵdaylarda fayl keńeytpesin ózgertiw kerek bolıwı múmkin. Mısalı, ".txt" 

keńeytpesine iye fayldı ".doc" keńeytpesine ózgertiw múmkin. Fayl keńeytpesin ózgertiwde 

itibarlı bolıw kerek. Ayırım jaǵdaylarda fayl ziyanlanıwı múmkin. 

 Fayllardı arxivlew: 

 Fayllardı arxivlew olardı kishi kólemde saqlawǵa, qorǵawǵa hám ańsat kóshiriwge járdem 

beredi. Fayl keńeytpelerin nátiyjeli basqarıw waqıttı tejewge, tártipsizlikti kemeytiwge hám 

fayllardı ańsat tabıwǵa járdem beredi. Bul sizge kompyuterińizde islewdi jáne de nátiyjeli hám 

qolaylı etedi. 

Fayllardı qıdırıw: Tez hám nátiyjeli tabıw usılları  

 Kompyuterde fayllardı tabıw waqtında kóbinese kóp waqıt sarplaymız. Bıraq, fayllardı tez 

hám nátiyjeli tabıw ushın bir neshe usıllar bar. 

 Qıdırıw filtrleri:  

 - Fayl atı boyınsha qıdırıw: Bul eń ápiwayı usıl. Fayl atı yamasa onıń bir bólegin jazıp, 

qıdırıwdı ámelge asırıwıńız múmkin. 

 - Fayl túri boyınsha qıdırıw: Mısalı, ".jpg" yamasa ".pdf" sıyaqlı fayl keńeytpelerin 

qıdırıwıńız múmkin. 

 - Fayl kólemi boyınsha qıdırıw: Kishi, orta hám úlken kólemdegi fayllardı qıdırıw 

múmkin. 

 - Ózgertirilgen sáne boyınsha qıdırıw: Fayldıń jaratılǵan yamasa ózgertirilgen sánesin 

kórsetip, qıdırıwıńız múmkin. 

 - Avtor boyınsha qıdırıw: Eger fayldıń avtorı málim bolsa, onı qıdırıwıńız múmkin. 

 - Gilt sózler boyınsha qıdırıw: Fayldıń quramında qanday gilt sózler bar ekenin kórsetip, 

qıdırıwıńız múmkin. 

Túrli fayllardı  eksport hám import qılıw. 

Ayırım waqıtlarda fayldı import qılıw 

zárúr boladı. Usı talap sebepli túrli programmalar 

túsine alatuǵın standart fayl túrleri islep 

shıǵılǵan. Standart túrdegi fayllarǵa mısallar: 

dawıslı maǵlıwmat ushın .mp3 fayl keńeytpesi, 

grafikalıq maǵlıwmat ushın .gif hám .jpg fayl 

keńeytpesi, tekst hám elektron kesteli 

maǵlıwmatlar ushın da standart fayl túrleri bar. 

Eger elektron kesteni comma separated 

values (útir menen ajıratilgan mánis, .csv) 

formatında saqlasańız, ol hár qanday elektron 

keste programmasında qollanıwı múmkin. Bul 

formattaǵı fayl elektron keste túrinen parq etip, 

hár qanday .csv keńeytpeli faylda bir dana keste 

bolıwı múmkin. Ol ketekshe, baǵana yamasa 

formatlaw ózgesheliklerin, atap aytqanda, 

formulanı da saqlamaydı. Maglıwmatlar óz ara 

útir menen ajıratılǵan halda tekstli fayl formasında saqlanadı. 

Fayl qanday import etiliwin túsiniw ushın aldın onıń qanday eksport etiliwin úyreniń. 

Tómendegi mısalda Microsoft Excel programması berilgen, biraq hár qanday elektron keste menen 

isleytuǵın programma processti usıǵan uqsas halda orınlaydı. Elektron kesteni .csv faylı sıpatında 

saqlaw ushın elektron keste faylın ashıń hám File > Save As buyrıǵın basıń. Save as type 

maydanındaǵı dizimnen CSV fayl keńeytpesin tańlań. Save túymesin basıń (2-súwretke qarań). 

2-súwret. (Sabaqlıqtaǵı 141-bettegi 11.03-súwret.) 

Elektron keste faylın .csv keńeytpesi retinde saqlaw  
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Fayldı saqlaw hám jaylastırıw. 

Fayldı basqarıw boyınsha bir neshe másláhát: 

 Hárbir faylǵa onıń ishinde ne bar ekenin tezlik penen aytıp beretuǵın at beriń. 

 Oǵan uqsas xarakterdegi fayldı saqlaw ushın papka jaratıń. 

 Papkalardı iyerarxiyalıq dúziliste saqlań. (3-súwretke qarań)  

Fayl atı. 

Fayldı atawdıń kóplegen usılları bar. Bul 

usıllardan ózíńizge sáykes keletuǵının 

tańlawıńız hám onnan úzliksiz túrde 

paydalanıwıńız múmkin. 

 Fayl atına hújjet jaratılǵan sáneni kiritiw 

múmkin. Máselen, ol 18-04-15 formasında 

boladı. 

 Hújjet mazmunın fayl atında kórsetiw 

múmkin. Máselen, shıǵarma_ushın_esletpe 

sıyaqlı. 

 Nátiyjede 18-04-5_de shıǵarma_ushın_esletpe.doc sıyaqlı fayl atı payda boladı (fayl atınan 

keyin noqat yamasa keńeytpeni jazıw shárt emes; paydalanılıp atırǵan programma bunı 

avtomatikalıq túrde siz ushın orınlaydı). 

 Saqlawdı juwmaqlawdan aldın fayldı qaysı papkada saqlaw kerekligin belgilew kerek; 

bunda My documents/School Work/English katalogına saqlawıńız múmkin. 

Fayldı túrli formatta basıp shıǵarıw. 

Qaralama hújjet. Hújjettiń aqırǵı nusqasın basıp shıǵarıw ornına hújjettiń qaralamasın 

basıp shıǵarıw múmkin. Kópshilik programmalar hújjettiń qaralama versiyasın basıp shıǵarıw 

imkaniyatın beredi. Bul, atap aytqanda, hújjette bir neshe hár qıylı shriftler yaki grafikler bar 

bolǵanda basıp shıǵarıwdı tezlestiredi, sebebi qaralamanı basıp shıǵarıwda túrli shriftler 

qollanbaydı hám grafikler belgilengen orında jaylaspaydı. 

Skrinshot. Eger Windowsdan paydalanıp atırǵanda ekrandaǵı qálegen nárseniń súwretin 

payda etiwdi qáleseńiz, bul klaviaturadaǵı print screen túymesi járdeminde ámelge asırıladı. 

Túyme PrnScr, PrtScn yamasa soǵan uqsas yarlıqqa iye boladı. Noutbukte bul process Fn 

yamasa funkcional túymeni basıp turıw arqalı ámelge asırıladı. Onı basqanıńızdan keyin, ekranıńız 

súwreti yad buferinde saqlanadı. Keyin súwretti basıp shıǵarıw ushın ol sáykes programmaǵa 

jaylastırıladı. Eger onı grafik fayl sıpatında saqlamaqshı bolsańız, súwret penen isleytuǵın 

programmaǵa jaylastırıń hám kerekli papkaǵa paydalanıw múmkin bolǵan grafik fayl sıpatında 

saqlań. 

Maǵlıwmatlar kestesi. Maǵlıwmatlar bazası kestesine maǵlıwmatlardı kiritkenińizden 

keyin, kesteniń nusqasın basıp shıǵarıwıńız múmkin. Maǵlıwmatlar bazası aynasınan Tables 

túymesin tanlań hám basıp shıǵarmaqshı bolǵan keste atın tanlań. Fayl menyusi arqalı yamasa 

basıp shıǵarıw ikonkasın basıw arqalı basıp shıǵarıladı. 

Grafik/diagramma. Elektron keste programmasında diagramma jaratqanıńızdan keyin 

onı basıp shıǵarmaqshısız. Siz bul jumıstı keste maǵlıwmatı menen yamasa óz aldına ámelge 

asırıwıńız múmkin. Diagrammanı bettegi kerekli jerge kóshirip, maǵlıwmatıńızdıń ólshemine 

sáykes túrde ózgertip, keyin basıp shıǵarıń. Diagrammanı hújjetten óz aldına kóriniste basıp 

shıǵarıw múmkin. Bunıń eń ápiwayı usılı onnan nusqa alıw hám basqa jumısshı betke jaylastırıw, 

keyin ólshemin bir bet ushın sáykeslendirgen halda basıp shıǵarıw. 

Brauzerdegi hám HTML kórinisindegi veb bet. Veb betti HTMLda basıp shıǵarıwdan 

aldın, onı aldın sol formatta kóriw hám qátelerin dúzetiw kerek. View menyusi tańlanadı keyin 

Source or Source Code túymesi basıladı. Kóp web betlerde jiyekten paydalanadı. Nátiyjede bir 

neshe veb betler bir ekranda kóriledi. Dáslepki kórinis kórsetilgeninen keyin hújjet basıp 

shıǵarıladı. 

3-súwret. (Sabaqlıqtaǵı 142-bettegi 11.04-súwret.) 

Fayllardı basqarıwdıń iyerarxiyalıq dúzilisi. 
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Joqarıda keltirilgen maǵlıwmatlardı oqıwshılarǵa jetkeriwde interaktiv metodlardan 

paydalanıw arqalı joqarı nátiyjelerge erisemiz. 

 

2. Temanı oqıtıwda ınteraktiv metodlardan paydalanıwdıń abzallıqları. 

Fayllardı nátiyjeli basqarıw zamanagóy dúnyada zárúrli kónlikpe esaplanadi. Bul process 

tek ǵana texnikalıq bilimlerdi emes, shólkemlestiriwshilik qábiletin de talap etedi. Oqıwshılarǵa 

bul temanı úyretiwde dástúriy usıllar - mısalı, tek teoriyalıq sabaqlar yamasa lekciyalar  kóbinese 

jetkilikli nátiyje bermeydi. Sebebi, fayllardı basqarıw ámeliy kónlikpe bolıp, onı tek esitiw yamasa 

oqıw arqalı emes, bálki ámelde sınap kóriw menen ózlestiriw múmkin. Bul jerde ınteraktiv 

metodlar óziniń nátiyjesin kórsetedi. 

Interaktiv usıllardan nátiyjeli paydalanıw bilim beriw procesine aktivlik, ızleniwsheńlik 

keypiyatın asıradı, oqıwshılarda óz múmkinshiliklerine isenim hám óz miyneti nátiyjesinen 

qanaatlanıwshılıq  sezimin keltirip shıǵaradı, bilim alıwǵa bolǵan qızıǵıwshılıqların jáne de 

asıradı. Bul bolsa, bilimlendiriw procesinde oqıwshılar shaxsın bárkámal etiwdiń zárúrli faktorları 

bolıp esaplanadı. Oqıtıwshı hám oqıwshı arasındaǵı qatnaslar da zárúrli áhmiyetke iye. [2] 

 Interaktiv metodlar degende oqıwshılardı aktiv qatnasıwǵa, olardıń qızıǵıwshılıǵın 

oyatatuǵın hám ámeliy tájiriybe arttırıwǵa járdem beretuǵın oqıtıw usılları túsiniledi. Mısalı, 

toparlarda islew, ámeliy tapsırmalar, simulyaciya oyınları yamasa real turmıslıq jaǵdaylardı 

eliklew sıyaqlı usıllar bar. Bul metodlar oqıwshılardı passiv tıńlawshıdan aktiv qatnasshıǵa 

aylandıradı. Fayllardı basqarıw sıyaqlı temada bul júdá zárúrli, sebebi oqıwshılar óz qátelerin 

ámelde kórip, olardı ońlawdı úyrenedi. Usınıń sebebinen, ınteraktiv metodlardan paydalanıw tek 

ǵana oqıw procesin qızıqlı etip qoymastan,  bilimlerdi tereń ózlestiriwge de járdem beredi. 

 Bunnan tısqarı, ınteraktiv metodlar oqıwshılardıń hár qıylı oqıw usıllarına iykemlesedi. 

Ayırım adamlar maǵlıwmattı esitiw arqalı, basqaları bolsa kóriw yamasa qol menen islew arqalı 

jaqsı qabıl etedi. Interaktiv usıllar bul  hár bir oqıwshınıń ózine sáykes tárizde bilim alıw 

imkaniyatın beredi.  

Fayllardı nátiyjeli basqarıw temasın oqıtıwda bir neshe interaktiv metodlardı kórip 

shıǵamız. 

Interaktiv oyın: “Fayllar dizayneri” Metod: Toparlıq jumıs hám rol bólistiriwi. 

Maqseti: Oqıwshılarda joybar dúziw, papkalardı ham fayllardı tártiplestiriw kónlikpesin 

qáliplestiriw hám rawajlandırıw. 

  Oqıwshılarda shaqqanlıq hám juwapkershilikti asırıw, waqıt penen islesiw kónlikpesin 

rawajlandırıw maqsetinde 5 minut waqıt beremiz. Oqıwshılardı klasstaǵı oqıwshılar sanınan kelip 

shıǵıp eki yaki úsh oqıwshıdan toparlarǵa bólemiz. Toparda bir oqıwshı bas dizayner, qalǵanları 

dizayner járdemshisi boladı. Hár bir toparǵa “Siziń klasıńız ushın oqıw materialları, joybarlar hám 

jeke fayllar ushın eń nátiyjeli papka strukturasın joybarlaw” tapsırmasın beremiz. Oqıwshılarǵa 

kompyuterde Windows operacion sistemasında berilgen tapsırma boyınsha papkalar jaratıw 

imkaniyatı beriledi. Oqıwshılar papkalardı jaratıw barısında fayllardı tártiplep papkalarǵa 

jaylastırıp saqlaw kónlikpesine iye boladı. (qarań 4-súwret) Oqıwshılar ózleriniń papkalar 

strukturasın usınadı, basqa toparlar bul jaratılǵan papkalar strukturasına óz pikirlerin aytıp 

ótedi.Oqıtıwshı eń nátiyjeli strukturanı atap ótedi.   

 
 4-Súwret. Oqıwshılar dúziwi múmkin bolǵan papkalar 

strukturası. 
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Interaktiv oyın: “Maǵan aytpa, maǵan kórset”. Metod: Toparlıq jumıs. 

Maqseti: Oqıwshılarda fayllardı keńeytpelerine qarap tanıp alıw, dóretiwshilik qabiletlerin 

rawajlandırıw.  

Bul metodta aldin ala A4 format qaǵazdı tórtke bólip, monitor súwretin túsirip tayarlaymız. 

(qarań  5-súwret) Fayl keńeytpeleri jazılǵan  tarqatpa kartochkalar tayarlaymız (qarań 6-súwret). 

Oqıwshılardı eki toparǵa bólemiz. Topar atları oqıwshılar qálewi boyınsha qoyıladı. Eki toparǵa 

fayl keńeytpeleri jazılǵan kartoshkalardan hám monitor súwreti túsirilgen tarqatpa materiallardan 

tarqatamız. Birinshi topar qolındagı fayl keńeytpesi jazılǵan kartochkanı (máselen XLS keńeytpesi 

jazılǵan) ekinshi toparǵa kórsetedi. Ekinshi topar monitor súwreti túsirilgen tarqatpa materialǵa 

kartochkada kórsetilgen fayl keńeytpesin sızıp (máselen keste formasın sızıp) kórsetiwi kerek. Óz 

gezeginde ekinshi topar óz kartochkasın kórsetedi, birinshi topar bul fayl keńeytpesin súwretlep 

kórsetiwi kerek. Toparlar wazıypalardı orınlap bolaman degenshe qollarındaǵı fayl keńeytpeleri 

haqqında hesh nárse aytpaydı. Wazıypa orınlanıp bolǵannan soń  har bir topar fayl keńeytpeleri 

haqqında ózleriniń salǵan súwretlerine sıpatlama beredi. Bul jerde ne ushın sonday súwret salǵanın 

ham fayl keńeytpesin qısqa túsindirip ketedi. Oqıtıwshı toparlardıń fayl keńeytpelerin súwretlep 

salǵan súwretlerin ham toparlar maǵlıwmatların analız etedi, qáteleri bolsa dúzetedi. Toparlardı 

xoshametleydi. Fayl keńeytpelerin men basqasha súwretlegen bolar edim dep taxtaǵa oqıwshılar 

súwretlegeninen basqasha formada súwret sızıp kórsetse, oqıwshılardı jane de fayl keńeytpelerin 

eslep qalıwǵa, dóretiwshilik qábiletlerin rawajlandırıwǵa úles qosqan bolamız. 
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Interaktiv metod: Fayl keńeytpeleri: Ótmish, búgin hám keleshek.  

Bul metodtan paydalanıw ushın oqıwshılarǵa tómendegi maǵlıwmatlardı túsindirip ótiw 

kerek.  Fayl keńeytpeleri (mısalı,.txt,.pdf,.jpg) cifrlı dúnyada maǵlıwmat strukturasınıń tiykarǵı 

bólegi bolıp, ótken asirde qáliplesken, házirgi kúnde keń tarqalǵan hám keleshekte jańa sırtqı 

kórinislerge ótip atırǵan túsinik bolıp tabıladı.  

 Ótmishte fayl keńeytpeleri 

  Fayl keńeytpeleri tariyxı 1960-jıllarǵa barıp taqaladı. Sol dáwirde paydalanılǵan qatar 

keńeytpelerge mısal etip .com (komandalar ushın), .exe (orınlawǵa tayar fayllar) hám .doc 

(Microsoft Word dáslepki hújjet formatları) keltiriw múmkin. Usınıń menen birge, 1990 -jıllarǵa 

shekem .wps (WordPerfect) hám .flo (floppy disk suwretleri) sıyaqlı keńeytpeler de ámelde 

bolǵan, biraq olar házirde derlik paydalanılmaydı.  

 Búgingi kúnde fayl keńeytpeleri 

 Házirgi kúnde eń keń tarqalǵan fayl keńeytpeleri ańsat paydalanıw, kóp platformada isley 

alıw hám maǵlıwmattı nátiyjeli saqlaw imkaniyatın beredi. .pdf (Portable Document Format, 

1993-jılda Adobe tárepinen usınıs etilgen) házirde hújjetler ushın standart format bolıp, universal 

qásiyetleri sebepli barlıq jerde qollanıladı. Sonıń menen birge, .jpg (Joint Photographic Experts 

Group, 1992) súwretler ushın eń ataqlı formatlardan biri bolıp, veb-saytlar hám smartfonlarda keń 

tarqalǵan. .mp3 (audio fayllar ushın, 1991-jılda baslanǵan) búgingi kúnde muzıka saqlawda 

tiykarǵı rol oynaydı. Bul keńeytpelerdiń atı olardıń maqsetin anıq ańlatadı: .pdf - “portable” hújjet, 

.jpg - súwret hám .mp3 - audio fayl. Házirgi kúnde zamanagóy programmalıq támiynat hám bultlı 

texnologiyalar sebepli bul keńeytpeler derlik hár bir qurılma menen sáykes keledi. 

Keleshekte fayl keńeytpeleri 

  Keleshekte fayl keńeytpeleri jáne de natiyjelilew, kishilew kólemli hám jańa texnologiyalar 

menen sáykes keletuǵın formatlarǵa ótiwi kútilip atır. Mısalı, .avif (Av1 Image File Format, 2019 

-jılda usınıs etilgen) suwretler ushın jańa format bolıp, .jpg hám .png ga qaraǵanda sapanı saqlap, 

kólemin azaytadı. Bul format veb-saytlar hám mobil qurılmalarda barǵan sayın kóbirek qollanılıp 

atır. Sonıń menen birge, .heic (High Efficiency Image Container, Apple tárepinen 2017-jılda 

qollanılǵan ) iPhone'larda súwretler ushın standart bolıp, keleshekte kóbirek qollanılıwı kútilip 

atır. .json (JavaScript Object Notation, 2000-jıllardıń basınan baslanǵan) veb maǵlıwmat 

almaslawda barǵan sayın zárúrli bolıp atır. Keleshektegi keńeytpelerdiń atları olardıń 

texnologiyalıq abzallıqları hám maqsetlerin sáwlelendiredi, mısalı, .avif - avtomatikalıq túrde sapa 

hám kólemdi optimallastırıwdı ańlatadı. 

Oqıwshılardı kompyuterge eki oqıwshıdan otırǵızamız, sebebi fayllardı taqlawda bir biri 

menen pikir alısıwı kerek. Kompyuterde tayarlangan tapsırmanı oqıwshılarǵa beremiz. Keste 

kórinisinde tayarlanǵan tapsırmada oqıwshılar ótmishde, házirgi kúnde hám keleshekte 

paydalanılatuǵın fayllardı tiyisli ketekshelerge tuwrı jaylastırıw kerek. (qarań  1-keste)  
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Interaktiv usıl. Túsirip qaldırılǵan sózlerdi tap. Toparlarda islew.  

Maqseti: Oqıwshılardıń pikirlew qábiletin rawajlandıradı hám túsiniw kónlikpelerin asırıwǵa 

járdem beredi. 

Tómende fayllardı basqarıw temasında túsirip qaldırılǵan sózlerdi kiritiw ushın qısqa 

tekstler keltirilgen. Bul tekstlerde bos orın belgileri ornına kiritiliwi kerek bolǵan túsirip 

qaldırılǵan sózlerdi tawıp qoyıń: 

#1. Tekst 

Fayllardı nátiyjeli basqarıw ushın aldın olardı tuwrı _____ (tártiplew) hám at beriw zárúr. Hár bir 

fayl ushın anıq hám mazmunlı ______(at) tańlaw, keyinirek onı tabıwdı ańsatlastıradı. Sonıń 

menen birge, fayllardı kerekli orınǵa ______ (saqlaw) hám kerek waqıtta rezerv nusqasın saqlawdı  

umıtpań. 

# 2. Tekst 

Kompyuterde fayllardı ______ (tártiplestiriw) ushın papkalar jaratıw usınıs etiledi. Mısalı, jumıs, 

jeke hám basqa _______ (kategoriyalar) boyınsha bólek papkalar ashıwıńız múmkin. Bul fayllardı 

izlew waqtında ______ (waqıt) tejewge járdem beredi. 

# 3. Tekst 

Fayllardı elektron pochta arqalı jiberiwden aldın, olarǵa _____ (qosımsha) fayllardı qosqanıńızǵa 

isenim payda etiń. Basqa paydalanıwshılar ushın málim bir _____ (format) ta saqlanǵan fayllardı 

tańlaw da zárúrli bolıp tabıladı. Bul olarǵa fayldı ańsat _____ (ashıw) ǵa járdem beredi. 

 # 4. Tekst 

 Fayllardı basqarıw processinde _____ (qátelik) lerdi kemeytiw ushın hár bir fayldı úzliksiz túrde 

_____ (jańalaw) zárúr. Fayl  redaktorlanǵannan keyin, ózgerislerdi ______ (saqlaw) dı umıtpań, 

keri jaǵdayda zárúrli maǵlıwmattı joǵaltıw qáwpi bar. 

 

Oqıwshılardı eki toparǵa bólip, bul tekstlerdi beremiz. Oqıwshılar toparlarda oylasıp 

pikirlesip, bir sheshimge kelip sózlerdi tawıp orınlarına jazıp beredi. Bul metodikanı 

paydalanıwdıń ahmiyeti túsirip qaldırılǵan sózlerdi toltırıw oqıwshılardıń pikirlew qábiletin 

rawajlandırıwǵa hám túsiniw kónlikpelerin asırıwǵa járdem beredi.  

Interaktiv metod: Oqıwshılar bilimlerin bekkemlewde krossvord hám 

chaynvordlardan paydalanıw.  

 Krossvord hám chaynvordlar oqıwshılar bilimlerin bekkemlewdiń nátiyjeli hám qızıqlı 

usıllarınan biri bolıp tabıladı. Olar oqıwshılardı ózlestirilgen maǵlıwmatlardı eslep qalıwǵa, olardı 

hár qıylı kontekstlerde qóllawǵa hám óz bilimlerin sınap kóriwge úndeydi. 

Krossvord hám chaynvordlar abzallıqları:  

Bilimlerdi bekkemlew hám tekseriw: Krossvord hám chaynvordlar oqıwshılardı 

ózlestirilgen maǵlıwmatlardı eslep qalıwǵa hám olardı hár qıylı kontekstlerde qóllawǵa 
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iytermeleydi, oqıwshılardıń maǵlıwmatlardı qanshelli jaqsı ózlestirgenligin tekseriwge járdem 

beredi. 

Sóz baylıǵın asırıw: Krossvord hám chaynvordlar jańa sózlerdi úyreniw hám olardı eslep 

qalıwǵa járdem beredi.  

Logika hám analiz qábiletin rawajlandırıw: Krossvord hám chaynvordlar oqıwshılardıń 

logika hám analiz qábiletin rawajlandırıwǵa járdem beredi. 

Qızıqlı hám oyınlı: Krossvord hám chaynvordlar oqıwshılar ushın qızıqlı hám oyınlı, 

báseki elementi bolıp, olardı úyreniwge bolǵan qızıǵıwshılıǵı artadı. 

 Krossvord hám chaynvordlardan paydalanıw boyınsha usınıslar : 

 - Temaǵa sáykes keletuǵın krossvord hám chaynvordlardı saylań. 

 - Oqıwshılardıń jası hám bilimlerine sáykes keletuǵın krossvord hám chaynvordlardı 

tayarlań. 

 - Krossvord hám chaynvordlardı qızıqlı hám oyın retinde paydalanıwǵa háreket etiń. 

 - Oqıwshılarǵa krossvord hám chaynvordlardı sheshiwde járdem beriń. 

Oqıwshılarǵa tómendegishe krossvord hám chaynvord dúzip temanı bekkemlewde 

paydalanamız. 

 

 

 

 

 

 

 

 

 

 

 

 

     

 

Enine. 1. .doc, .docx fayl keńeytpelerin ashıp beriwshi programma 

2. Faylǵa kiritilgen ózgeristi saqlaw buyrıǵı. 

3. Maǵlıwmatlardı basqa programmalarda da ashıw ushın qayta saqlaw. 

5. Fayl atı hám keńeytpesin ... ... belgisi ajıratıp turadı. 

8. Bul fayl keńeytpesi "Extensible Markup Language" (Keńeyttirilgen belgilew tili) faylların 

ańlatadı. 

Tigine. 2. Kompyuter ekranın súwretke alıw. 

4. Keste faylları menen islesetuǵın programma. 

6. Tekstli fayl keńeytpesi. 

7. Maǵlıwmattı at berip diskte saqlaw. 

 Ótilgen temanı bekkemlew metodı. Ótilgen temanı bekkemlewde oqıwshılarǵa 

tómendegi kesteni tarqatamız. Oqıwshılar jeke tártipte kestede berilgen atamalar táriypleri menen 

tanısıp, óz jeke kóz qarasların arnawlı belgiler arqalı bildiredi. Oqıwshılarǵa 5-8 minut waqıt 

beriledi. Belgilengen waqıt juwmaqlanǵannan soń, oqıwshılar ushın tanıs emes hám túsiniksiz 

bolǵan  maǵlıwmatlar oqıtıwshı tárepinen analiz qılınıp, tusindirilip, olardıń mazmunı tolıq 

ashıladı. Oqıwshılardıń qosımsha sorawlarına juwap beredi. 
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Túsinikler 

mazmunı 

V 

 

(bilgen edim) 

__ 

 

(aldıńǵı 

bilgenlerime 

tuwrı 

kelmeydi) 

+ 

 

(qızıqlı, men 

ushın jańa 

bilim) 

? 

 

(túsiniksiz, 

sorawlarım 

bar) 

! 

 

(Kóbirek 

biliwdi 

qaleymen, 

meni lal 

qaldırǵan 

maǵlıwmat) 

 

Fayl keńeytpesi 

 

     

Fayllardı 

import hám 

eksport etiw. 

     

Joǵaltıwlı hám 

joǵaltıwlarsız 

tıǵızlaw. 

     

  

 Joqarıda kórsetilgen interaktiv metodlar arqalı biz oqıwshılardıń temaǵa bolǵan 

qızıǵıwshılıǵın arttırıp ǵana qoymastan, temanı yadlarında saqlap qalıw, zarúr bolǵanda  

paydalanıw kónlikpelerin rawajlandıramız. 

 

3. Oqıwshılardıń bilimin bahalaw usılları. 

Házirgi kúnde oqıwshılardıń pánlerdi tereń úyreniwi, qızıǵıwshılıqlarınıń rawajlanıwı, 

ózlestirgen bilimlerin ámeliyatda qóllaw, kásipke baǵdarlawdı shólkemlestiriw, ádebiyatlar 

ústinde óz betinshe islew kónlikpelerin qáliplestiriw, internet sisteması járdeminde informaciya 

izlew, alıw hám qayta islewdi úyreniw menen birge olarǵa bilimlerin qadaǵalawdıń jańa 

mexanizmlerin ámeliyatqa engiziwdi úyretiw maqsetke muwapıq boladı. Bul baǵdarda 

oqıwshılardıń bilimlerin bahalaw úlken ahmiyetke iye. [1] 

 Fayllardı nátiyjeli basqarıw zamanagóy cifrlı dúnyada zárúrli kónlikpe bolıp, 

oqıwshılardıń bul kónlikpelerdi ózlestiriwi olardıń kúndelik hám oqıw iskerliginde tabıslı bolıwına 

járdem beredi. Bul bólimde 9-klass oqıwshıları ushın “Fayllardı nátiyjeli basqarıw” teması 

boyınsha bilim hám kónlikpelerin bahalawǵa qaratılǵan metodikalıq usınıslar keltirilgen.  

Ne ushın oqıwshılardı bahalaw kerek? 

 Fayllardı nátiyjeli basqarıw oqıwshılarǵa cifrlı ortalıqta tártipli islew, maǵlıwmatlardı 

joǵaltıwdan saqlaw hám óz ornın tez tabıw imkaniyatın beredi. Oqıwshılardı bahalaw arqalı 

olardıń bul kónlikpelerdi qanshelli ózlestirgeni anıqlanadı hám oqıtıwshılarǵa oqıw procesin jáne 

de nátiyjeli shólkemlestiriwde járdem beredi. Bahalaw procesi tómendegi maqsetlerdi gózleydi: 

- Oqıwshılardıń teoriyalıq bilimlerin tekseriw. 

- Ámeliy kónlikpelerin sınaqtan ótkeriw. 

- Mashqalalardi sheshiw qábiletin rawajlandırıw. 

Teoriyalıq bahalaw usılları  

 Oqıwshılardıń fayl basqarıwı boyınsha teoriyalıq bilimlerin bahalaw ushın tómendegi 

usıllardan paydalanıw múmkin: 

1. Testler hám viktorinalar 

 Testler arqalı oqıwshılardıń fayl basqarıwdıń tiykarǵı túsinikleri haqqındaǵı bilimleri 

tekseriledi. Sorawlar qısqa hám anıq bolsa maqsetke muwapıq boladı. 

Fayllar basqarıwı teması boyınsha testlerden úlgi keltiremiz. 

  1. Qaysı juwap fayl atı hám fayl keńeytpesiniń tuwrı tariypin beredi? 

A) Fayl atı - fayldıń mazmunın, fayl keńeytpesi - fayl jaratılǵan sáneni kórsetedi.  

B) Fayl atı - fayl túrin, fayl keńeytpesi - fayldıń kólemin kórsetedi.  
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C) Fayl atı - fayldı anıqlaw ushın qollanılatuǵın unikal at, fayl keńeytpesi - fayl túrin anıqlaw 

ushın qollanılatuǵın qosımsha maǵlıwmat.  

D) Fayl atı - fayldıń jaylasqan papkasın, fayl keńeytpesi - fayldıń aqırǵı ózgeris kiritilgen sánesin 

kórsetedi. 

 Tuwrı juwap : C) Fayl atı - fayldı anıqlaw ushın qollanılatuǵın unikal at, fayl keńeytpesi - 

fayl túrin anıqlaw ushın qollanılatuǵın qosımsha maǵlıwmat. 

2.  "bmp" faylı qanday túrdegi fayl esaplanadı? 

 A) Súwretli fayl        B) Tekstli fayl           C) Video fayl               D) Audio fayl 

 Tuwrı juwap : A) Súwretli fayl 

 Túsindiriw: ". bmp" keńeytpeli fayllar "Bitmap fayl" rastrlı (piksellerden ibarat) súwret 

formatı ekenligin ańlatadı.  

3. CSV faylı ne ushın qollanıladı? 

 A) Súwretlerdi saqlaw ushın                                       B) Tekstli hújjetlerdi saqlaw ushın                                                                

C) Elektron keste maǵlıwmatların saqlaw ushın          D) Video fayllardı saqlaw ushın  

 Tuwrı juwap : C) Elektron keste maǵlıwmatların saqlaw ushın  

 Túsindiriw: CSV faylı "keste formatında saqlanǵan maǵlıwmatlar", yaǵnıy ol elektron 

keste maǵlıwmatların saqlaw ushın qollanıladı.  (qaran 2-qosımsha. test sorawları.)  

 Bul test sorawların oqıwshılardıń informaciyalıq texnologiyalarǵa bolǵan qızıǵıwshılıǵın 

arttırıw hám de kompyuterde test islew kónlikpelerin arttırıw maqsetinde quizziz.com saytında 

tayarlaymız. Testlerdi tayarlaw ushın quizziz.com platformasına kirip dizimnen ótemiz yaki 

google akkauntımız arqalı platformaǵa kirsek boladı. Platformada aldınnan tayarlaǵan test 

sorawların kompyuterde alsaq boladı. Kompyuter bolmaǵan yaki jetispegen jaǵdayda  quizziz.com 

saytında Q-kartalardan paydalanıp qaǵaz rejiminde (qarań. 3-qosımsha) test alsaq boladı. Bul 

waqıttan únemli paydalanıwda qol keledi. Oqıwshılardıń bahaları sistema tárepinen esaplanıp 

turıladı.  

2. Dóretpe yamasa oy-pikir jazıw. Dóretpe teması - “Fayllardı tártipli saqlaw oqıw 

procesimde qanday járdem beredi?” 

 Oqıwshılardan fayllardı basqarıwdıń áhmiyeti haqqında qısqa dóretpe jazıw soraladı. Bul 

usıl olardıń óz pikirlerin ańlatıw qábiletin de bahalaydı. Dóretpe dápter betiniń yarımı yaki A4 

formattaǵı qaǵazdıń yarımı kóleminde qısqa jazıladı. Oqıwshılar bul dóretpeni jazıwda fayllardı 

tártipli saqlaw ózlerine qanday qolaylıqlar jaratadı, fayllardı tártiplestiriw ne ushın kerek, qanday 

usıllarda tártiplew múmkin, fayllardı tártiplew ozleriniń oqıw procesinde qanday járdem beredi 

degen sorawlarǵa juwap beriw kerek. Dóretpeni jazıwǵa jeti, segiz minut waqıt bersek boladı. 

Oqıwshılardıń dóretpelerin bahalawda mazmuni, pikirler izbe-izligi, pikirlerin ańlatıw 

qábiletlerine itibar qaratamız.    

3. Awızsha soraw-juwap arqalı bahalaw. Maqseti: Oqıwshılar bilimlerin, tema 

boyınsha túsiniklerin operativ bahalaw, olardıń tosattan berilgen sorawlarǵa tezlik penen 

juwap qaytarıw qabiletlerin rawajlandırıw hám bahalaw.  

 Sabaq dawamında oqıwshılardan fayllar basqarıwı boyınsha tosatdan berilgen ápiwayı 

sorawlarǵa juwap beriwleri soraladı. Máselen oqıwshılarǵa fayllardı import hám eksport etiw 

haqqında túsinikler berilip atırǵan waqıtta, tosattan papkalar jaratıw haqqında soraw beremiz. 

Oqıwshılar oy pikiri fayllardı import hám eksport etiw haqqındaǵı túsinikler menen bánt bolǵan 

waqıtta, olarǵa papkalar jaratıw haqqında berilgen soraw bunnan aldın papkalar haqqında berilgen 

túsiniklerdi eslewge májbúrleydi. Bul usıl olardıń túsinigin operativ tekseriw hám har qanday 

jaǵdayda tosatdan berilgen sorawlarǵa juwap beriw  ushın qolay. 

Máselen oqıwshılarǵa tómendegi sorawlardı bersek boladı. 

- “Fayllardı tártipke salıwda papka strukturası qanday járdem beredi?” 

- “Fayl atın qoyıwda qanday talaplar bar?” 
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- “Fayllardı arxivlew bizge ne beredi?” 

 

 4. Ámeliy bahalaw usılları. Maqseti: Oqıwshılardıń fayllardı basqarıwın 

kompyuterde ámeliy qollay alıwın bahalaw.  

 Ámeliy kónlikpelerdi bahalaw oqıwshılardıń fayllardı basqarıwdı haqıyqıy jaǵdaylarda 

qollay alıwın kórsetedi. Tómendegi usıllar usınıs etiledi: 

Fayllardı tártipke salıw wazıypası.  

 Oqıwshılarǵa bir neshe fayl (mısalı, tekstli hújjetler, súwretler, keste faylları) beriledi hám 

olardan bul fayllardı kompyuterde ierarxik dúziliste tártipke salıw tapsırması beriledi. 

Berilgen fayllar: “Matematika_test. docx”, “Ingliz_tili_insho.pdf”, “Súwretler.jpg”. 

Wazıypa: Bul fayllardı “Mektep jumısları” degen tiykarǵı papkada “Matematika”, 

“Anglichan tili”, “Súwretler” ishki papkalar jaratıp, jaylastırıń. Bunda bahalaw kriteryaları: papka 

atlarınıń anıqlıǵı, fayllardıń tuwrı papkalarda jaylasıwı, dúzılıwdıń qolaylıǵı. 

5. Joybar jaratıw. Oqıwshılardan ózleriniń oqıw jumısların yamasa jeke joybarın fayllar 

retinde shólkemlestiriw soraladı. “Mektep portfeli” joybarında olar fayllardı pánler boyınsha 

tártipke salıp qoyıwı múmkin. Mısalı: “Matematika” papkasında testler, “Anglichan tili” 

papkasında dóretpeler saqlanadı. 

6. Fayl formatların tańlaw.  Oqıwshılardan málim bir wazıypa ushın tuwrı fayl formatın 

tańlaw soraladı. Mısalı, tekstli hújjetti saqlaw ushın .docx yamasa .pdf formatınan qaysısı abzal 

ekenligin tiykarlap beriwleri kerek.  Mısalı  “Dóretpe jazıp, onı .pdf  formatında saqlań hám 

sebebin túsindiriń.” 

7. Juwmaqlawshı bahalaw usılları: 

Oqıwshılardıń ulıwma bilim hám kónlikpelerin bahalaw ushın tómendegi usıllar 

qollanıladı : 

 7.1.  Portfel tekseriwi:  Oqıwshılardıń barlıq faylları hám papkaları dúzilisi tekseriledi. Bul 

olardıń uzaq múddetli tártipke ámel qılıw qábiletin kórsetedi. 

7.2. Prezentaciya: Oqıwshılar óz fayl strukturaların klasqa usınıs etedi hám qanday etip 

tártipke salǵanın túsindiredi. Máselen oqıwshılarǵa  “Nege bul fayldı bul papkaga jaylastırdıńız?” 

7.3. Mashqalanı sheshiw: Oqıwshılarǵa mashqala beriledi, mısalı, “Faylıńız joǵalǵan 

bolsa, onı qanday tabasız?” hám olardıń sheshimleri bahalanadı. 

Ámeliy másláhátler hám usınıslar:  Oqıwshılarǵa fayllardı basqarıwda járdem beriw 

ushın tómendegi másláhátler beriledi: 

- Fayl atlarında sáne (mısalı, 18-04-15) yamasa tema (mısalı, “Matematika_test”) isletiw. 

- Papkalardı pánler yamasa maqsetler boyınsha ajıratıw (mısalı, “Mektep”, “Jeke”). 

- Rezerv nusqaların saqlaw ushın sırtqı yad qurılmalarınan paydalanıw. 

 Fayllardı nátiyjeli basqarıw boyınsha oqıwshılardı bahalaw olardıń cifrlı dúnyada islew 

kónlikpelerin rawajlandıradı. Joqarıdaǵı usıllar hám metodikalar járdeminde oqıtıwshılar 

oqıwshılardıń teoriyalıq bilimlerin hám ámeliy islew qábiletlerin ádalatlı bahalaw múmkin. Bul 

process oqıwshılarǵa óz jumısların tártipli saqlawdı uyretedi hám keleshekte olarǵa úlken payda 

keltiredi. 

 Solay etip, bul usıllar járdeminde oqıwshılardıń fayllardı nátiyjeli basqarıw boyınsha 

teoriyalıq bilimlerin de, ámeliy kónlikpelerin de bekkemlew múmkin. 
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Juwmaqlaw. 

 

  Fayllardı nátiyjeli basqarıwdı úyretiwde ınteraktiv metodlardıń abzallıqları kóp tárepten 

paydalı boladı.  

Birinshiden, bul usıllar oqıwshılarǵa real turmıslıq jaǵdaylarda islew imkaniyatın beredi. 

Mısalı, oqıtıwshı oqıwshılarǵa “bir kompaniyanıń hújjetler arxivın tártipke salıw” sıyaqlı tapsırma 

beriwi múmkin. Bunda oqıwshılar toparlarǵa bólınıp, fayllardı klassifikaciyalaw, ataw hám saqlaw 

strategiyasın islep shıǵadı. Bul processde olar tek ǵana teoriyalıq bilimlerdi qollap ǵana 

qoymastan, toparlarda islew hám mashqalanı sheshiw kónlikpelerin de rawajlandıradı. 

 Ekinshiden, ınteraktiv metodlar oqıwshılardıń yadında uzaq múddet saqlanatuǵın tásirler 

qaldıradi. Ápiwayı lekciya tıńlaw menen salıstırǵanda, ámeliy shınıǵıwlarda qatnasqan oqıwshılar 

úyrengenlerin tezirek eslep qaladı hám onnan paydalana aladı. Mısalı, eger oqıwshı fayllardı bultlı 

yadta tártipke salıwdı simulyatsiya arqalı úyrense, ol keleshekte óz jumıs ornında sol usıldan 

biymálel paydalana aladı. Bul bolsa oqıtıwdıń tiykarǵı maqseti - ámeliy jaqtan payda keltiriwge 

xızmet etedi. 

 Úshinshiden, ınteraktiv metodlar oqıwshılar arasında báseki hám sheriklik ortalıǵın 

jaratadı. Mısal ushın, oqıtıwshı “eń tez hám nátiyjeli fayl sistemasın dúziw” boyınsha kishi jarıs 

shólkemlestiriwi múmkin. Bul oqıwshılardı aktiv qatnasıwǵa iytermeleydi hám olardıń 

dóretiwshilik jantasıwların asıradı. Sonıń menen birge, toparlarda islew oqıwshılarǵa bir-birinen 

úyreniw hám tájiriybe almasıw imkaniyatın beredi. Nátiyjede, fayllardı basqarıw boyınsha 

bilimlerdi tek ǵana oqıtıwshıdan emes, bálki óz teńleslerinen, doslarınan da alǵan boladı. 

 Keleshekte bul metodlardı jáne de rawajlandırıw ushın zamanagóy texnologiyalardan 

paydalanıw múmkin. Mısalı, virtual reallıq (vR) yamasa jasalma intellekt (AI) járdeminde 

fayllardı basqarıw proceslerin simulyatsiya qılıw oqıwshılarǵa jáne de real tájiriybe beriwi 

múmkin. Sonıń menen birge, onlayn platformalar arqalı ınteraktiv kurslar shólkemlestiriw de keń 

múmkinshiliklerdi ashadı. Bul bolsa tek ǵana klass ishinde emes, bálkim aralıqtan oqıtıwda da 

unamlı nátiyjelerge erisiwge járdem beredi. 

 Fayllardı nátiyjeli basqarıw kónlikpesi búgingi kúnde hár qanday tarawda - biznes, tálim 

yamasa jeke turmısda zárúrli áhmiyetke iye. Usınıń sebebinen, bul temanı oqıtıwda ınteraktiv 

metodlardan paydalanıw tek ǵana oqıtıwshılar ushın qolaylıq jaratıp qoymastan, oqıwshılardı da 

keleshektegi tabıslarǵa tayarlaydı. Hár bir oqıwshı óz tájiriybesi arqalı úyreniwi, jáne bul 

bilimlerdi turmısta qollawı ushın ınteraktiv usıllar eń jaqsı sheshim bolıp tabıladı. Sonday eken, 

oqıtıw processinde bul metodlardı keńirek qollawǵa itibar qaratıw zárúr. 

Juwmaqlap aytqanda, fayllardı nátiyjeli basqarıw temasın oqıtıwda ınteraktiv metodlardan 

paydalanıw oqıw procesin jáne de nátiyjeli hám qızıqlı etedi. Bul usıllar oqıwshılarǵa ámeliy 

kónlikpeler beredi, yadta uzaq saqlanatuǵın bilimlerdi qáliplestiredi hám toparlıq islew qábiletin 

asıradı. Dástúriy usıllar menen salıstırǵanda, ınteraktiv metodlar oqıwshılardıń itibarın uzaǵıraq 

uslap turadı hám olardı dóretiwshilik pikirlewge shaqıradı. 
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QOSÍMSHALAR. 

 

1-qosımsha. 

Bul qosımshada sabaqlıqtaǵı 141-bettegi (11.01-keste. Fayl túrleri) kestege fayl 

keńeytpelerine túsindirme berilgen.  

 

Keńeytpe Anıqlaw ham paydalanıw 

.bmp "Bitmap Image File" dep atalǵan súwret faylın ańlatadı. Bul Windows 

operatsion sistemasında standart súwret formatı esaplanadı. 

.css "Cascading Style Sheets" (Kaskadlı stil kesteleri) dep atalǵan fayldı ańlatadı. 

Bul veb-saytlardıń kórinisin hám formatın belgilew ushın qollanılatuǵın 

programmalastırıw tili bolıp tabıladı. 

.csv "Comma Separated values" (útir menen ajıratılǵan mánisler) dep atalǵan 

fayldı ańlatadı. Bul tekstli fayl bolıp, maǵlıwmatlardı keste formasında saqlaw 

ushın qollanıladı. 

.db "Database" (Maǵlıwmatlar bazası) dep atalǵan fayldı ańlatadı. Bul 

maǵlıwmatlardı saqlaw hám basqarıw ushın qollanılatuǵın fayl. 

.htm "HyperText Markup Language" (Gipertekstli belgilew tili) dep atalǵan fayldı 

ańlatadı. Bul veb-betlerdi jaratıw ushın qollanılatuǵın programmalastırıw tili 

bolıp tabıladı. 

.png "Portable Network Graphics" (Kóshpeli tarmaq grafikası) dep atalǵan fayldı 

ańlatadı. Bul súwret fayl formatı bolıp tabıladı hám súwret sapasın 

joǵaltpastan saqlaw múmkinshiligine iye. 

.ppt "Power Point Presentation" (Power Point prezentaciya) dep atalǵan fayldı 

ańlatadı. Bul Microsoft Power Point programması tárepinen jaratılǵan 

prezentaciya faylı bolıp tabıladı. 

.psd "Adobe Photoshop Document" (Adobe Photoshop hújjeti) dep atalǵan fayldı 

ańlatadı. Bul Adobe Photoshop programması tárepinen jaratılǵan súwret faylı 

bolıp tabıladı. 

.rtf "Rich Text Format" (Bay tekst formatı) dep atalǵan fayldı ańlatadı. Bul tekst 

fayl formatı bolıp tabıladı, ol tekstti, shriftlerdi, reńlerdi, paragraflardı, 

kestelerdi hám basqa formatlaw elementlerin saqlaydı. 

.tif "Tagged Image File Format" (Belgilengen súwret fayl formatı) dep atalǵan 

fayldı ańlatadı. Bul súwret fayl formatı, ol joqarı sapalı súwretlerdi saqlaw 

ushın arnalǵan. 

.txt "Plain Text" (Ápiwayı tekst) dep atalǵan fayldı ańlatadı. Bul tekst fayl formatı, 

formatlaw elementleri yamasa basqa maǵlıwmatlarsız tek tekstti saqlaydı. 

.zip "ZIP Archive" (ZIP arxiv) dep atalǵan fayldı ańlatadı. Bul fayldı tıǵızlaw 

formatı, ol bir neshe fayldı birden-bir faylǵa tıǵızlap, fayl kólemin azaytadı. 
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2-qosımsha. 

Bul qosımshada “Fayllardı nátiyjeli basqarıw” teması boyınsha oqıwshılar bilimlerin 

bahalaw ushın test sorawları berilgen. 

1. Qaysı juwap fayl atı hám fayl keńeytpesiniń tuwrı tariypin beredi? 

A) Fayl atı - fayldıń mazmunın, fayl keńeytpesi - fayl jaratılǵan sáneni kórsetedi.  

B) Fayl atı - fayl túrin, fayl keńeytpesi - fayldıń kólemin kórsetedi.  

C) Fayl atı - fayldı anıqlaw ushın qollanılatuǵın unikal at, fayl keńeytpesi - fayl túrin anıqlaw 

ushın qollanılatuǵın qosımsha maǵlıwmat.  

D) Fayl atı - fayldıń jaylasqan papkasın, fayl keńeytpesi - fayldıń aqırǵı ózgeris kiritilgen sánesin 

kórsetedi. 

 Tuwrı juwap : C) Fayl atı - fayldı anıqlaw ushın qollanılatuǵın unikal at, fayl keńeytpesi - fayl 

túrin anıqlaw ushın qollanılatuǵın qosımsha maǵlıwmat. 

2.  "bmp" faylı qanday túrdegi fayl esaplanadı? 

 A) Súwretli fayl        B) Tekstli fayl           C) Video fayl               D) Audio fayl 

 Tuwrı juwap: A) Súwretli fayl 

3. CSV faylı ne ushın qollanıladı? 

 A) Súwretlerdi saqlaw ushın                                       B) Tekstli hújjetlerdi saqlaw ushın                                                                

C) Elektron keste maǵlıwmatların saqlaw ushın          D) Video fayllardı saqlaw ushın  

 Tuwrı juwap: C) Elektron keste maǵlıwmatların saqlaw ushın  

 4. CSV faylın qanday etip jaratıw múmkin? 

A) " File > New" buyrıǵı arqalı                                   

B) "File >Save As" buyrıǵı arqalı hám formattı CSV  etip tańlaw arqalı  

C) " Edit > Copy" hám " Edit > Paste" buyrıqları arqalı        

D) " Insert > Picture" buyrıǵı arqalı  

 Tuwrı juwap: B) " File > Save As" buyrıǵı arqalı hám formattı CSV etip tańlaw arqalı.  

5.  Tómendegi keltirilgen fayl túrlerinen qaysısı maǵlıwmatlardı tıǵızlaw texnologiyası 

tiykarında jaratılǵan hám maǵlıwmat uzatıw ushın qollanıladı? 

 A) txt              B) zip                  C) xml                   D) pdf 

 Tuwrı juwap: B) zip 

 6. Keltirilgen fayl túrlerinen qaysısı formatlarsız ápiwayı tekstli fayl esaplanadı? 

 A) txt              B) zip                  C) xml               D) pdf 

 Tuwrı juwap: A). txt 

 7. XML faylın ashıwdıń eń ańsat usılı neden ibarat? 

 A) Fayldı arxivator programması járdeminde ashıw     

 B) Fayldı tekstli redaktor programması járdeminde ashıw 

 C) Fayldı brauzer programması járdeminde ashıw 

 D) Fayldı eki ret basıw hám kompyuterde ornatılǵan standart programmalardan birin tańlaw  

 Tuwrı juwap: D) Fayldı eki ret basıw hám kompyuterde ornatılǵan standart programmalardan 

birin tańlaw  

 8. Fayllardı saqlaw hám jaylastırıwda qanday máslahátlerge ámel qılıw kerek? 

 A) Fayllardı atawda olardıń mazmunın sáwlelendiriwshi qısqa hám túsinikli at beriw hám birdey 

túrdegi fayllardı bólek papkalarda saqlaw. 

 B) Fayllardı saqlawda olardıń kólemin minimallastırıw hám olardı tez-tez nusqalaw. 

 C) Fayllardı saqlawda olardıń túrin hám jaratılǵan sánesin esapqa alıw hám olardı álipbe 

tártibinde jaylastırıw. 

 D) Fayllardı saqlawda olardıń jaylasqan manzilin yadta saqlaw hám olardı parol menen qorǵaw. 

 Tuwrı juwap: A) Fayllardı atawda olardıń mazmunın sáwlelendiriwshi qısqa hám túsinikli at 

beriw hám birdey túrdegi fayllardı bólek papkalarda saqlaw. 
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 9.  Fayllardı saqlawda papkalardı qanday dúziw kerek? 

 A) Fayllardıń jaratılǵan sánesine qaray                           B) Fayllardıń túrine qaray 

 C) Fayllardıń mazmunına qaray                                      D) Fayllardıń kólemine qaray 

 Tuwrı juwap: C) Fayllardıń mazmunına qaray. 

10. Fayl atına qanday maǵlıwmatlardı kirgiziw múmkin? 

 A) Tek fayl jaratılǵan sáneni                                  B) Tek fayl mazmunın  

C) Fayl jaratılǵan sáneni hám fayl mazmunın        D) Fayl atına hesh qanday maǵlıwmat kiritip       

                                                                                      bolmaydı  

 Tuwrı juwap: C) Fayl jaratılǵan sáneni hám fayl mazmunın  

11. Hújjettiń qaralama nusqasın basıp shıǵarıw qanday artıqmashılıqlarǵa iye? 

 A) Basıp shıǵarıw tezligin asıradı. 

 B) Túrli shriftler hám grafiklardı qóllaw imkaniyatın beredi.  

C) Hújjettiń juwmaqlawshı nusqasın basıp shıǵarıwdan kóre arzanlaw.  

D) Barlıq juwaplar tuwrı . 

 Tuwrı juwap: A) Basıp shıǵarıw tezligin asıradı.  

12. Kompyuterde skrinshot alıw ushın qaysı tuymeni basıw kerek? 

 A) Alt       B) Ctrl       C) Print Screen       D) Shift 

 Tuwrı juwap: C) Print Screen 

13. Joǵaltıwlarsız tıǵızlaw qanday maǵlıwmatlar menen islewde qollanıladı? 

 A) Tek tekstli maǵlıwmatlar menen                 B) Tek cifrlı maǵlıwmatlar menen  

C) Tekstli hám cifrlı maǵlıwmatlar menen       D) Hár qanday túrdegi maǵlıwmatlar menen 

 Tuwrı juwap: C) Tekstli hám cifrlı maǵlıwmatlar menen 

14.  Zip texnologiyası qanday tıǵızlaw túrine mısal bola aladı? 

 A) Joǵaltıwlı tıǵızlaw                                       B) Joǵaltıwlarsız tıǵızlaw 

 C) Aralas tıǵızlaw                                             D) Tıǵızlawdıń túri emes 

 Tuwrı juwap : B) Joǵaltıwlarsız tıǵızlaw 

15.  Ne ushın .txt faylı keńeytpesinen paydalanıw tekst qanday saqlanǵanın bilmesten de 

tekstli fayldı almasıw múmkinligin ańlatadı? 

 A) Sebebi .txt faylı barlıq operacion sistemalar tárepinen qollap -quwatlanadı.  

B) Sebebi .txt faylı eń kishi kólemge iye.  

C) Sebebi .txt faylı hesh qanday formatlaw belgilerin óz ishine almaydı.  

D) Sebebi .txt faylı ashıq kodlı format esaplanadı. 

 Tuwrı juwap: A) Sebebi .txt faylı barlıq operacion sistemalar tárepinen qollap -quwatlanadı. 
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3-qosımsha. 

Bul qosımshada quizziz.com onlayn platformasında interaktiv testten paydalanıwda qaǵaz rejimi 

Q-kartalardan paydalanıw boyınsha kórsetpe berilgen. (kórsetpe quizziz.com saytınan alındı.) [7] 
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